LEECON <& AUTOMOTIVE  Eactory Innovation Week (=

b WORLD

R&D and Manufacturing

Entry Plan

- Applicants for 8.1sqm need to apply for Entry Plan (Space and Rental Display System Package) -

Choose your Rental Display System Type from A, B and Design

Type A Design Type

2026 Shows 2027 Shows 2026 Shows 2027 Shows
Raw Space* JPY 570,000 JPY 600,000 Raw Space* JPY 570,000 JPY 600,000
Rental Display JPY 290,000 JPY 310,000 Rental Display JPY 290,000 JPY 310,000
Expo Master (standard pian) JPY 150,000 JPY 150,000 Expo Master (standard pian) JPY 150,000 JPY 150,000
Total JPY 1,010,000 JPY 1,060,000 Total JPY 1,010,000 JPY 1,060,000
(approx. USD 6,510) (approx. USD 6,840) (approx. USD 6,510) (approx. USD 6,840)

_ List of Furniture A Type List of Furniture Design Type

> Back & Side Walls > 1 Dustbin > Back & Side Walls > 6 Spotlights (100W)

» FasciaBoard > 5 Spotlights (100W) » Carpet > 1 0utlet

> Carpet > 10utlet > 1 Reception Counter & > 1 Meeting Table & 2 Chairs
> 1Display Table > Power Supply up to TkW 1 Counter Chair > Power Supply up to 2kW

> 1 Meeting Table & 2 > 1 Dustbin » Back Wall Design Print

Chairs

> 1Reception Counter & Select 1 Option Below
1 Counter Chair » Option A: 1 Table + 2 Chairs
> 1 Catalogue Stand » Option B: Display Table " ; ;

» Option C: High Counter

> 5 Spotlights
> 1 Display Table (W2000 x D700 x H1000 or H750)

> 1 Wall Graphic on Back Panel ’

For Brand Marketing ‘ > 1 Selectable Furniture Set

[ For Exhibiting Various Contents ‘

2026 Shows 2027 Shows List of Furniture B Type
Raw Space* JPY 570,000 JPY 600,000 yp
. » Back & Side Walls > 1 Dusthin
Rental Display JPY 220,000 JPY 240,000  FasciaBoard 1 Spotlight (100W)
Expo Master (standard plan) JPY 150,000 JPY 150,000 » Carpet > 2 Flourescent Lamps
> 1 Display Table > 10utlet
Total JPY 940,000 JPY 990,000 > 1 Meeting Table & 2 Chairs > Power Supply up to TkW
> 1 Reception Counter &
(approx. USD 6,070) (approx. USD 6,390) 1 Folding Chair
[ For Easy Set-up \ > Simple Design > Includes Necessary Furniture ]

Click here for the Details Click here for the Details °

of EXPO MASTER of RENTAL DISPLAY SYSTEM

Notes » The prices quoted in USD are for your reference only. (USD 1 =JPY 155 / as of 2025.12.19.)
> Corner charge is JPY 50,000 per corner. Applied only when a corner booth is allotted.
> EXPO MASTER (exhibitor platform) is mandatory Option. Service Fee will be charged: JPY150,000 for exhibitor without co-exhibitor / JPY 200,000 for exhibitor with co-exhibitor(s).
> Japanese Consumption Tax (10%) will be added to the total price.
> The furniture included in packaged booths are subject to change. Please check the exhibitor manual updated on Exhibitor Portal for the details.


https://lp.rxjapan.jp/expomaster_en/
https://lp.rxjapan.jp/rental_display_system_en
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b WORLD
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Raw Space Rental Fee (1 booth: 16.2sqm)

September (Tokyo) / November (Nagoya) / February (Tokyo) / May (Osaka)
Edition in 2026 & 2027

September (Tokyo) Show: November (Nagoya) Show: February (Tokyo) Show: May (Osaka) Show:
Dates: Sep. 9(Wed) - 11(Fri), 2026 Dates: Nov. 25(Wed) - 27(Fri), 2026 | Dates: Feb. 17(Wed) - 19(Fri), 2027 | Dates: May 12(Wed) - 14(Fri), 2027
Venue: Makuhari Messe, Japan Venue: AICHI SKY EXPO, Japan Venue: Tokyo Big Sight, Japan Venue: INTEX Osaka, Japan

JPY 1,140,000 / 16.2sqm (6.0m x 2.7m) (approx. USD 7,400) JPY 1,200,000 / 16.2sqm (6.0m x 2.7m) (approx. USD 7,740)

Note: AUTOMOTIVE WORLD is held in Feb./Sep./Nov.

TypeA Design Type

2026 Shows 2027 Shows 2026 Shows 2027 Shows
Raw Space* JPY 1,140,000 JPY 1,200,000 Raw Space* JPY 1,140,000 JPY 1,200,000
Rental Display JPY 580,000 JPY 620,000 Rental Display JPY 580,000 JPY 620,000
Corner Charge JPY 50,000 JPY 50,000 Corner Charge JPY 50,000 JPY 50,000
Expo Master (standard plan) JPY 150,000 JPY 150,000 Expo Master (standard plan) JPY 150,000 JPY 150,000
Total JPY 1,920,000 JPY 2,020,000 Total JPY 1,920,000 JPY 2,020,000
(approx. USD 12,400) (approx. USD 13,040) (approx. USD 12,400) (approx. USD 13,040)

List of Furniture Design Type

List of Furniture A Type _ ,
B » Back & Side Walls 6 Spotlights (100W)

>
) ll > Back & Side Walls 1 Counter Chair > Carpet > 10utlet
| > FasciaBoard > 1 Catalogue Stand | » 1 Reception Counter & > 1 Meeting Table & 2 Chairs
> Carpet > 1 Dustbin 1 Counter Chair > Power Supply up to 2kW
> 2 Display Tables > 10 Spotlights (100W) > 1Dustbin > Back Wall Design Print
> 2 Meeting Tables & 8 > 2 Outlets
>

Chairs Power Supply up to 2kwW Select 1 Option Below
> 1 Reception Counter & » Option A: 1 Table + 2 Chairs @ Q @
» Option B: Display Table
A B C

» Option C: High Counter

For Exhibitin
9 > Stock Room (W1500 x D700 x H1000 or H750 / 2-level type Front:

W2000 x D500 x H750 + Back: W2000 x D500 x H1000)

For Brand Marketin
‘ ‘ > 1 Selectable Furniture Set

> 10 Spotlights > 2 Display Tables ]

[ Various Contents

> 1 Wall Graphic on Back Panel ’

2026 Sh 2027 Sh . .
026 Shows 027 Shows List of Furniture B Type

Raw Space* JPY 1,140,000 JPY 1,200,000 i

Rental Display JPY 440,000 JPY 480,000 et ) oy

Corner Charge JPY 50,000 JPY 50,000 > Carpet > 10 Spotlights (100W)
> 1 Display Table > 2 Outlets

Expo Master (standard pian) JPY 150,000 JPY 150,000 > 2 Meeting Tables &8 Chairs > Power Supply up to 2kW
> 1 Reception Counter &

Total JPY 1,780,000 JPY 1,880,000 1 Counter Chair
(approx. USD 11,500) (approx. USD 12,130)
[ For Easy Set-up \ > Simple Design » Includes Necessary Furniture ]

Click here for the Details Click here for the Details °

of EXPO MASTER of RENTAL DISPLAY SYSTEM

Notes » The prices quoted in USD are for your reference only. (USD 1 =JPY 155 / as of 2025.12.19.)
> Corner charge is JPY 50,000 per corner. Applied only when a corner booth is allotted.
> EXPO MASTER (exhibitor platform) is mandatory Option. Service Fee will be charged: JPY150,000 for exhibitor without co-exhibitor / JPY 200,000 for exhibitor with co-exhibitor(s).
> Japanese Consumption Tax (10%) will be added to the total price.
> The furniture included in packaged booths are subject to change. Please check the exhibitor manual updated on Exhibitor Portal for the details.


https://lp.rxjapan.jp/expomaster_en/
https://lp.rxjapan.jp/rental_display_system_en
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Raw Space Rental Fee (1.5 booth: 24.3sqm)

September (Tokyo) / November (Nagoya) / February (Tokyo) / May (Osaka)
Edition in 2026 & 2027

September (Tokyo) Show: November (Nagoya) Show: February (Tokyo) Show: May (Osaka) Show:
Dates: Sep. 9(Wed) - 11(Fri), 2026 | Dates: Nov. 25(Wed) - 27(Fri), 2026 | Dates: Feb. 17(Wed) - 19(Fri), 2027 | Dates: May 12(Wed) - 14(Fri), 2027
Venue: Makuhari Messe, Japan Venue: AICHI SKY EXPO, Japan Venue: Tokyo Big Sight, Japan Venue: INTEX Osaka, Japan

JPY 1,710,000 / 24.3sqm (9.0m x 2.7m) (approx. USD 11,050) JPY 1,800,000 / 24.3sqm (9.0m x 2.7m) (approx. USD 11,620)

Note: AUTOMOTIVE WORLD is held in Feb./Sep./Nov.

TypeA Design Type

2026 Shows 2027 Shows 2026 Shows 2027 Shows
Raw Space* JPY 1,710,000 JPY 1,800,000 Raw Space* JPY 1,710,000 JPY 1,800,000
Rental Display JPY 870,000 JPY 930,000 Rental Display JPY 870,000 JPY 930,000
Corner Charge JPY 50,000 JPY 50,000 Corner Charge JPY 50,000 JPY 50,000
Expo Master (standard plan) JPY 150,000 JPY 150,000 Expo Master (standard plan) JPY 150,000 JPY 150,000
Total JPY 2,780,000 JPY 2,930,000 Total ~ JPY 2,780,000 JPY 2,930,000
(approx. USD 17,950) (approx. USD 18,910) (approx. USD 17,950) (approx. USD 18,910)

List of Furniture Design Type

List of Fu rniture A Type > Back & Side Walls > 10 Spotlights (100W)
> Carpet > 2 Outlets
> Back & Side Walls > 2 Catalogue Stands » 2 Reception Counters & > 2 Meeting Table & 4 Chairs
» FasciaBoard > 1 Dusthin 2 Counter Chairs > Power Supply up to 3kW
> Carpet » 15 Spotlights (100W) > 2 Dustbins » Back Wall Design Print
> 3 Display Tables > 3 Outlets
> 2 Meeting Tables & 8 Chairs > Power Supply up to 3kW Select 1 Option Below @ Q @
> 1 Reception Counter & » Option A: 1 Table + 2 Chairs
1 Counger Chair > StockRoom » Option B: Display Table
» Option C: High Counter A B C
For Exhibitin > 15 Spotlights > 3 Display Tables . > 1 Wall Graphic on Back Panel
[ Various Contents ‘ » StockRoom (W20 x D700  H1000 or H750) x 3 ] For Brand Marketing ‘ 1 Selectabre Furniture Set ’

2026 Shows 2027 Shows List of Furniture B Type
Raw Space* JPY 1,710,000 JPY 1,800,000 ! AR o Back & Side Walls 1 Cataloque Stand
| > I > u
Rental Display JPY 660,000 JPY 720,000 | ‘ [ » FasciaBoard 5y 1 Dustbi?\
Corner Charge JPY 50,000 JPY 50,000 i T L P Carpet , 2 Spotlights (100W)
EXpo Master sundardpon)  JPY 150,000 PYso000 L e e s chais | soute
> 1 Reception Counter & > Power Supply up to 2kW
Total JPY 2,570,000 JPY 2,720,000 1 Folding Chair
(approx. USD 16,580) (approx. USD 17,550) X - -
[ For Easy Set-up ‘ > Simple Design > Includes Necessary Furniture ]

Click here for the Details of EXPO MASTER ©

Notes » The prices quoted in USD are for your reference only. (USD 1 =JPY 155 / as of 2025.12.19.)
> Corner charge is JPY 50,000 per corner. Applied only when a corner booth is allotted.
> EXPO MASTER (exhibitor platform) is mandatory Option. Service Fee will be charged: JPY150,000 for exhibitor without co-exhibitor / JPY 200,000 for exhibitor with co-exhibitor(s).
> Japanese Consumption Tax (10%) will be added to the total price.
> The furniture included in packaged booths are subject to change. Please check the exhibitor manual updated on Exhibitor Portal for the details.


https://lp.rxjapan.jp/expomaster_en/
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AUTOMOTIVE
WORLD

Raw Space Rental Fee (2 booths: 32.4sqm)

Factory Innovation Week @v

September (Tokyo) / November (Nagoya) / February (Tokyo) / May (Osaka)
Edition in 2026 & 2027

September (Tokyo) Show:
Dates: Sep. 9(Wed) - 11(Fri), 2026
Venue: Makuhari Messe, Japan

November (Nagoya) Show:
Dates: Nov. 25(Wed) - 27(Fri), 2026
Venue: AICHI SKY EXPO, Japan

JPY 2,280,000 / 32.4sqm (6.0m x 5.4m) (approx. USD 14,710)

February (Tokyo) Show:
Dates: Feb. 17(Wed) - 19(Fri), 2027
Venue: Tokyo Big Sight, Japan

May (Osaka) Show:
Dates: May 12(Wed) - 14(Fri), 2027
Venue: INTEX Osaka, Japan

JPY 2,400,000 / 32.4sqm (6.0m x 5.4m) (approx. USD 15,490)

Note: AUTOMOTIVE WORLD is held in Feb./Sep./Nov.

TypeA Design Type

2026 Shows 2027 Shows 2026 Shows 2027 Shows
Raw Space* JPY 2,280,000 JPY 2,400,000 Raw Space* JPY 2,280,000 JPY 2,400,000
Rental Display JPY 1,160,000 JPY 1,240,000 Rental Display JPY 1,160,000 JPY 1,240,000
Corner Charge JPY 100,000 JPY 100,000 Corner Charge JPY 100,000 JPY 100,000
Expo Master (standard plan) JPY 150,000 JPY 150,000 Expo Master (standard plan) JPY 150,000 JPY 150,000
Total JPY 3,690,000 JPY 3,890,000 Total  JPY 3,690,000 JPY 3,890,000

(approx. USD 23,810)

(approx. USD 25,100)

List of Furniture A Type
Back & Side Walls » 1 Catalogue Stand
FasciaBoard > 1 Dustbin
> 4 Plants

(approx. USD 23,810)

(approx. USD 25,100)

Bhenc

List of Furniture Design Type

>

>

> Carpet

> 4 Display Tables

> 3 Meeting Tables &
12 Chairs

> 1 Reception Counter &
1 Counter Chair

> 20 Spotlights (100W)
> 4 Outlets
> Power Supply

up to 4kW

Select 1 Option Below
» Option A: 1 Table + 2 Chairs
» Option B: Display Table
» Option C: High Counter

e » Back & Side Walls > 10 Spotlights (100W)
> Carpet > 2 Outlets
— > 2 Reception Counters & > 2 Meeting Table & 4 Chairs
2 Counter Chairs > Power Supply up to 4kW
> 2 Dustbins > Back Wall Design Print

YOO

> 20 Spotlights

[ For Exhibiting Various Contents ‘ , 4 Display Tables

> Stock Room

For Brand Marketin
g ‘ > 2 Selectable Furniture Set

|

> 1 Wall Graphic on Back and 1 Side Walls ’

2026 Shows 2027 Shows : List of Furniture B Type

Raw Space* JP¥ 2,280,000 JPY 2,400,000 TI ] | == 1 Back & Side Walls 1 Catalogue Stand

> | > u
Rental Display JPY 880,000 JPY 960,000 ‘ ] e o b

T | y
Corner Charge JPY 100,000 JPY 50,000 ar AL T ‘ 7 > Carpet > 4 Spotlights (100W)
EXpo Master sandaarny  JPY 150,000 JPY 150,000 i | e 4 12 Chalrs + 4ot
L > 1 Reception Counter & > Power Supply up to 4kW
Total JPY 3,410,000 JPY 3,560,000 1 Folding Chair
. USD 22,000 .USD 22,970
(@pprox ) (approx ) [ For Easy Set-up ‘ > Simple Design > Includes Necessary Furniture ]

Click here for the Details of EXPO MASTER ©

Notes » The prices quoted in USD are for your reference only. (USD 1 =JPY 155 / as of 2025.12.19.)
> Corner charge is JPY 50,000 per corner. Applied only when a corner booth is allotted.
> EXPO MASTER (exhibitor platform) is mandatory Option. Service Fee will be charged: JPY150,000 for exhibitor without co-exhibitor / JPY 200,000 for exhibitor with co-exhibitor(s).
> Japanese Consumption Tax (10%) will be added to the total price.
> The furniture included in packaged booths are subject to change. Please check the exhibitor manual updated on Exhibitor Portal for the details.


https://lp.rxjapan.jp/expomaster_en/

